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PREPARE

Prepare. Create. Check. These three words are the mantra for version 11 
of PPA’s Pass4press, which contains the latest settings and information to 
help you create print-ready PDFs that will keep printers happy and give 
you the results you expect. They are based on using PDF/X-1a: this is a 
subset of the PDF family geared specifically towards printing, so it can’t 
contain things like movies, links or other nasty objects that can cause 
PDFs to fail or corrupt during the print production process. Pass4press 
follows international guidelines on creating print-ready PDFs, specifically 
the work of the Ghent Workgroup (GWG). They’ve done the hard work 
and established the most reliable and consistent way to make a PDF: pretty 
much all major publishers base their specifications on the GWG’s work. 
Simply put, these settings work. This brochure concentrates on the tools 
available in the newest applications from Quark and Adobe. More in-depth 
information, along with settings for older versions of XPress and InDesign 
and other applications capable of creating PDF/X-1a files are available on 
the pass4press.com website. 

When you see this icon in the margin:
...it means there are downloadable presets available online. Where 

possible, use these presets as a starting point.

When you see this icon in the margin:
...check the pass4press website for more detailed information. A 

single-page Pass4press Recommended Workflow diagram is also available 
from the site.

Go through your application preferences and make sure they’re set up 
appropriately for your job. To make sure the final result looks exactly as 
expected, it’s crucial that the correct colour profile is used as a reference 
from the beginning of the process through to the creation of the final, flat 
CMYK PDF/X-1a file. Colour profiles don’t exist to make your life more 
complex: quite the reverse. They provide a colour-accurate framework for 
you to create your job. Use the wrong profile and there’s a big chance your 
page will produce unexpected results when printed.  

In your Adobe applications, set up a Colour Settings File (CSF) from the 
Edit menu. Use Adobe Bridge to synchronise the settings across additional 
Adobe applications. In QuarkXPress, set up Output Styles. Once these 

colour settings are saved, configure your PDF export presets. Use 
the downloadable settings available from pass4press.com as a 

starting point, modifying profile information as necessary according to 
publishers’ specifications, or use the screen grabs from relevant section 

below as a reference. Setting your Transparency Flattener preset 
(Edit menu) is crucial: see example below.

If you’re going to trust the colour on your display, take some basic 
measures to improve accuracy. Ideally use a calibration tool, such 

APPLICATION SET-UP

THE GUIDELINES
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as an i1Display or Spyder, or at the very least use the ColorSync calibration 
utility on a Mac. The quality of your monitor will have an effect, as will your 
surroundings. Reflections and bright colours dramatically affect what’s seen 
on screen. 
As sad as it may seem, you’ll also need to remove the office party snap used 
as your desktop pattern and replace it with a neutral grey. This will mean less 
extraneous colours distracting your eyes from the colours on your page. In 
Photoshop, use the full screen mode (press the F key) to help isolate images.

MENU SHORTCUTS
Edit>Colour Settings
InDesign>Prefs>Appearance Of Black
File>Adobe PDF Presets
Edit>Transparency Flattener Presets
Edit>Colour Setups>Source
Edit>Colour Setups>Output
QuarkXPress>Preferences>Job 
Jackets
Edit>Output Styles
QuarkXPress>Preferences>PDF

CREATE
PAGE CREATION

 CHECK
Bleed, Trim and Type areas

At the absolute minimum, ensure the publisher has supplied you with the 
mechanical sizes (trim, bleed and type), print resolutions and target 
CMYK profile. Always set up your document to reflect the trim size 

of the publication. You can set the bleed as part of the document set-up in 
InDesign or with the Guide Manager Pro XTension in Xpress, which will give 
you a visual cue as to how far you need to extend elements off the page to 
compensate for any movement on-press. Bleed will be incorporated as part 
of the PDF export process, as will crop marks. All colours in your document 
must be CMYK. Check your Swatch palette to make sure no RGB or Spot 
colours are present: convert them as necessary. Note that placed graphics 
can import swatches with them. Transparency effects require proper layering 

to avoid the introduction of artefacts by the flattening process as part 
of the PDF/X-1a file creation. Layering is particularly important if the 

effects overlap text. The flattening resolution (see App Set-up) will solve most 
problems, but keep objects with transparency on separate layers to help the 
process work properly.

WWW
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WWW
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CONTENT PREPARATION
Most pages will contain some form of external file – an image or imported 
text. Making sure these files are correctly prepared is a fundamental part of 
creating your page. When importing text, look for unexpected style sheets 
which can add rogue fonts or characters into your document. All fonts used in 
a document should be available on your system, licensed and in an accepted 
format (most commonly PostScript pairs, TrueType or modern OpenType). 
Fonts used in document will be embedded in the final PDF.

There are plenty of image formats that can be used (compressed JPG, 
various types of TIFF or native Photoshop PSD files) but all are subject 

to the same rules. You can use the PDF export process to convert images to 
CMYK, but you could be disappointed with the results. With photographic 
images, work in Photoshop with your colour management settings correctly 
set for the job in hand and use its soft-proofing option (View>Proof Colours) 
to see how the image will look when converted to CMYK, before carrying out 
the final conversion. 

Certain colours which look good in RGB on your screen will simply 
never print with the same vibrancy when converted to CMYK, 

 CHECK
Have you got the target profile?
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BLEED
Extra space around the 
edge of a page to allow 
for movement on press.  

TRIM
The final trimmed size of 
the magazine.

TYPE
The ‘safe’ area that 
you should keep to for 
important text or images.

MENU SHORTCUTS
Window>Swatches
Type>Find Font...
Window>Links
Window>Layers
Window>Colours
Utilities>Usage
Window>Layers
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particularly neons, deep blues and bright reds. You will have to colour retouch 
these images to achieve the result you want. The recommended workflow is 
to only place converted CMYK images, unless you’ve already previewed the 
result in Photoshop (or using InDesign’s own View>Proof Colours option) and 
are satisfied with the result.
Vector images, normally originated in an application like Illustrator, need to 
be carefully handled. They should be created in the correct CMYK space 
(File>Document Colour Mode) and have the relevant raster effects settings 

(File>Document Setup) set to the print resolution of the publication. 
Be wary of spot colours and placed images; make sure the effective 

resolution of the latter is still high enough. Illustrator can also be used 
to create and output pass4press-compliant PDFs directly: all the 
guidelines for InDesign apply. Presets and an export settings guide are 

available online.

When using 1-bit images, make sure the image is very high resolution for 
the optimal results: normally 2400dpi. Both XPress and InDesign handle 

basic overprint and trapping needs. There’s usually no need to change 
any settings unless you’ve been advised to as part of the publication 

specification. It’s unusual to want a placed object to appear only on the black 
channel, as the result will usually look ‘washed out’. If making a ‘rich’ black, 
don’t overdo the percentage of additional colours used to achieve this effect. 
Remember, most magazines aim for a maximum ink percentage of 300-
320% for Web Offset work, or 340-360% for Gravure: ink limits are in place 
to prevent too much ink soaking the paper as it’s printing, causing web breaks: 
an expensive problem to have. If you’re using the correct profile for the job, 
this will prevent these ink limits being exceeded.

WWW

WWW
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 CHECK
Is your content prepared in the 
correct CMYK colour space

LIVE PREFLIGHT
The latest versions of Adobe InDesign and QuarkXPress have built-in methods 
of verifying your content as the document is being created. This means you 
can pick up on potential problems as soon as they occur. Under InDesign CC’s 
Output menu there are four tools you can use to check your layout: Flattener 
Preview, Preflight, Separations Preview and Trap Presets. A basic Preflight 
is turned on by default; the Preflight panel provides a comprehensive set of 
dynamic tools to check almost every aspect of your document, from font 
usage through images, resolutions and print settings. Feedback is displayed 

>

pass4press
version 11

1: PREVIEW
Proof the image using the target 
profile in Photoshop. Retouch the 
image as necessary.

2: CONVERT
Convert the image to the target 
CMYK profile and save it down.

3: PLACE/UPDATE
Place the image on your page, or 
update the link if it’s already been 
positioned
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via a simple traffic light icon: green means your page is good to go, red means 
that errors have been detected. Preflight is on by default, but use the 
downloadable pass4press prefight profile to give your document a 

thorough check. Preflight profiles can also be embedded into the document 
itself, to ensure consistent checking as pages are passed around.
QuarkXPress introduced its ‘Job Jackets’ feature in version 7, and it’s been 
further refined in later versions. Job Jackets are based on JDF, a form of 
XML created specifically for print, and allow you to create and monitor a job 
according to the instructions contained in the Jacket. XPress’ soft proof option 
is under View>Proof Output. This uses the Output style you have selected as 
the basis for an on-screen preview of the target colour space. For an accurate 
view of placed images turn on Full Res Previews from the View menu. 

To proof colours in InDesign, choose View>Proof Setup to select either the 
profile embedded in the document or the application’s defaults – these may 
be the same if you originated the document. Check the View>Proof Colours 
option to turn on or off soft proofing dynamically. Overprint Preview can be 
turned on from the View menu, which will give you an idea of any overprint 
problems where objects could be accidentally hidden. Display Performance 
must be set to High Quality Display to enable accurate viewing of placed 
images.

WWW
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INDESIGN export PDF

1 Create a Transparency Flattener 
Preset from the Edit menu, using the 

settings below – this will be selected in the 
Advanced tab (see step 8)

2 Select File>Export, then in Format 
choose Adobe PDF. Name the file, select 

the folder where you want to save it and click 
Save

3 In General select the single page to 
print. Set the Compatibility to Acrobat 

4 (PDF 1.3) and deselect all of the listed 
Options and Include checkboxes

4 The Compression tab sets the options 
for how the PDF will handle resolutions 

for placed colour, greyscale and monochrome 
images

7 Ensure there are only process inks and 
no Spot colours. Converting colours 

to CMYK at the PDF creation stage can give 
unpredictable results

6 Use the Destination and Output 
Intent Profile Name relevant to the 

publication. ISO Coated V2 300 is used here as 
an example only

5 The Printer’s Marks should be 
enabled as below. Set the Weight to 

0.25pt, the Offset set at 3mm and the Bleed 
to 3mm all round

8 Select the Transparency Flattener 
previously created. OPI should be 

disabled. Here is also where you can opt to 
create a JDF file

9 Make sure all the options in Security 
are disabled. Summary lists all the 

settings that will be applied: it can be saved as a 
text file for reference

Recommended settings for exporting a PDF/X-1a from InDesign CC (v9) or higher.  
This example was created on Mac OS X 10.8.4 using InDesign CC (v9.2.1).
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QUARKXPRESS export PDF
Recommended settings for exporting a PDF/X-1a from QuarkXPress 9 or higher.  
This example was created on Mac OS X 10.8.4 using QuarkXPress 9.

1 Open QuarkXPress>Preferences and 
choose the PDF tab: change the setting 

to Direct To PDF
2 Choose File>Export>Layout As PDF. 

Choose a location to save the file. In PDF 
Style choose a relevant preset or click Options 
and enter the details as shown 

3 Metadata can be entered as required. 
Hyperlinks must be disabled. Use the 

Compression options to set how placed images 
will be handled

6 In Marks set the Mode to Centred, 
with a Width of 0.25pt (or 0.088mm), a 

Length of 5mm and an Offset of 5mm
5 Set all fonts to download using the 

Select All button4 In Colour make sure there are only the 
four process colour plates, with no RGB 

or spot colour separations, and set the Mode to 
Composite

7 The Bleed should be Symmetric at 
3mm distance. Using Clip At Bleed Edge 

means matter outside the bleed isn’t included in 
the PDF, reducing its size

8 Set the Transparency options as 
below. When outputting a PDF a Layers 

tab will also be visible: ensure all  
the relevant layers are set to output

9 OPI must be disabled. JDF information 
can be added to the PDF using a job 

ticket. Summary shows all the settings used 
for the PDF

pass4press
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CHECK
ACROBAT SET-UP
Every PDF should be verified before being passed down the chain, using 
flightcheck software along with a visual check. Even if all the guidelines for 
document creation and preflight are followed, there is always the possibility 
of something slipping through. There are many large server-based systems 
available in the marketplace, such as Dalim Twist, One Vision Asura and 
Enfocus Pitstop Server, plus client applications like Markzware Flightcheck 
and Pitstop, all capable of processing anything from individual PDFs to entire 
catalogues. Evaluate and choose the software that is right for your needs. 

Preconfigured settings files for most of these systems are available 
from www.gwg.org. 

Adobe Acrobat Pro includes a flightcheck and two other useful tools that you 
should always use: Output Preview and the Print Production Toolbar. There 
are some key preferences to set in Acrobat before you commence any print 
production work, specifically in the Page Display and Colour Management 
tabs. 
PAGE DISPLAY: DEFAULT LAYOUT AND ZOOM
This is purely aesthetic, but setting it to Single Page and Fit Page means every 
PDF will open fitting to the window.
PAGE DISPLAY: RESOLUTION
This must be set to the System Setting to ensure accurate display of pixels on 
the page.
PAGE DISPLAY: RENDERING
All boxes should be unchecked to make sure the PDF is rendered accurately 
using fonts from the file and without artificial smoothing. Having these 
switched on can typically show up misleading thin white lines which aren’t 
actually there – they are minute artefacts from transparency flattening when 
a PDF is exported. If these options are off and lines are still visible it means the 
document wasn’t layered properly or the flattening resolution wasn’t sufficient 
– the PDF will need to be re-exported.
PAGE DISPLAY: PAGE CONTENT & INFORMATION
Turn on the options you want: they all make useful details about a PDF 
immediately apparent as soon as you open a file. 

COLOUR MANAGEMENT
Ensure your settings are in sync with your other applications.

WWW

WWW

PRINT PRODUCTION TOOLBAR
This toolbar (Advanced>Print Production>Show Print Production Toolbar) 
gives quick access to a range of tools for checking and correcting PDF files. It 
is best practice to correct errors on the original document rather than a PDF, 
but these tools can still help with file checking. The toolbar can be floating or 
docked to the toolbar of any PDF so it will open automatically. 
01 TRAP PRESETS
Allows you to create and apply trap settings for later execution by a 
PostScript 3 RIP.
02 OUTPUT PREVIEW
The most useful tool. Another way to open the Output Preview – see below 
for details.

MENU SHORTCUTS
Acrobat>Preferences>Advanced> 
Print Production>Output Preview
Advanced>Print Production> 
Print ProductionToolbar> 
Advanced>Preflight
Tools>Analysis>Measuring Tool

pass4press
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03 PREFLIGHT 
See below for more details. 
04 CONVERT COLORS 
Converts RGB, CMYK and Grey colour spaces to a target colour space. Normal 
procedure would be to carry out all conversions prior to the PDF creation and 
supply flat CMYK files ready prepared the destination space.
05 INK MANAGER 
Modifies the way separations are treated while the current PDF is open.
06 ADD PRINTER MARKS 
Adds standard printer marks to a PDF page for positioning which are 
embedded in the PDF.
07 CROP PAGES 
Crop Pages allows you to quickly see the size of all the embedded page 
boxes, such as Trim, Type and Bleed, without manually measuring objects. 
Just choose the box from the menu and set your measurement unit: the 
dimensions will be shown by the page thumbnail, with guides showing its 
location.
08 FIX HAIRLINES 
Identifies hairlines.
09 TRANSPARENCY FLATTENING 
Controls rasterisation during print output. Correctly-created PDF/X-1a files 
cannot contain transparent elements.
10 PDF OPTIMIZER 
Provides many settings for inspecting, analysing, and repairing documents.
 11 JDF JOB DEFINITIONS 
Allows you to create custom job definitions. The JDF file may also include 
information necessary for the creation of PDFs, including PDF conversion 
settings and preflight profiles.

OUTPUT PREVIEW
Output Preview is your friend. The Simulation Profile pop-up at the top of 
the window will display the profile that the PDF/X-1a was created with 
(ie, its Output Intent), so straight away tells you if it’s been created to the 
correct CMYK. If you want to preview the PDF in a different colour space, 
choose the another profile from the pop-up list. At the top of the palette 
you can also turn on additional options:
SIMULATE BLACK INK
This makes blacks look realistically grey,  making rich blacks or show-
throughs more visible.
SIMULATE PAPER COLOR
The paper simulation used in a profile can be enabled to get an idea of the 
paper colour.
SIMULATE OVERPRINTING
Overprints will be simulated – this should always be on (it’s enabled by 
default in Acrobat). 
SHOW
The Show pop-up allows you to quickly isolate and view certain types 
of content. Need to see just the text that uses embedded fonts, just the 
images or only the RGB elements? Use Show. 
In the main window are three more Preview tools: click on them to select 
these options:
SEPARATIONS
View all separations and use the tickbox to look at them individually or in 
combinations. Set a value, checking the TAC box to highlight ‘hot’ areas, 

pass4press
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using the different sample sizes to reduce overly sensitive warnings. Click Ink 
Manager to see the separation ink densities and their order.
COLOR WARNINGS
Turn on Overprinting or Rich Black warnings to highlight potential problem 
areas. 
OBJECT INSPECTOR
This allows you to easily access details on images and objects embedded in 
a PDF. Click on any element, such as an image, to show detailed information 
about that object. You’ll see the colour space, pixel and print size, resolution, 
overprint setting and original rendering intent. Resolution can be a bit 
confusing; if you’ve set Acrobat’s Units & Guides preferences to Metric then 
the resolution will be displayed in Dots Per CM rather then Per Inch. It can 

be useful to leave your guides as Metric and create a conversion table 
with relative DPCM and DPI values to use as a reference. 

MEASURING
By default Acrobat’s Measuring Markup and Snap tools are turned on, which 
can make things a bit frustrating as they try to snap to everything in sight: 
turn them off in Preferences>Measuring (2D). Select the ruler tool from 
Tools>Analysis> Measuring Tools or click the ruler icon in the toolbar. Click 
the first point, holding down the Shift key to constrain the ruler in a straight 
line. The distance will be shown at the end of the line and additionally in the 
floating Distance Tool window.

WWW

FLIGHTCHECK
Acrobat Pro comes ready-installed with a flightcheck profile created by the 
Ghent Workgroup. You can use this as-is or as a base for creating your own 
custom profile for a particular set of printing conditions. Open it up from 
Tools > Print Production > Preflight, select the MagazineAds profile under 
the Prepress heading and click Edit. Duplicate the setting using the icons in 
the left-hand corner and then work through the settings, checking against 
your job requirements. There are a selection of main headings checking 
major issues, but there’s also a Custom Checks section where incredibly 
detailed additional checks can be added. Useful things like trim size, bleed 
measurements, TAC, hairlines and resolutions can all be checked.

USING THE ACROBAT PRO FLIGHTCHECK
From the Tools Menu choose Print Production > Preflight (or press Apple-
Shift-X) to bring up the flightcheck panel. There are three kinds of check 
available from the icons along the top of the panel, next to the Show All 
pop-up: Profiles, Single Checks and Fix-ups. Profiles are the most useful, but 
single checks can be used if you need to quickly check just one thing. Try 
and avoid using Fix-ups: it really is better and safer to go back to the original 
document, especially if it has been supplied to you by a client.

There are plenty of profiles built-in, but the Magazine Ads spec (or ones 
based on it) is the most relevant to magazines. Select the flightcheck setting 
and then click Analyse. Wait for the file to process and then check the 
results window. If the PDF has failed you can save a record of the problems 
for further analysis by clicking Create Report. Select the Details>Problems 
Highlighted By Layers option, then Save.

ANALYSING FLIGHTCHECK RESULTS
The report PDF contains a first page that summarises any problems that 
have been found with the page and then a copy of the original PDF with the 
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problem elements highlighted using layers. A list of common errors is on the 
next page. The report page contains three sections: 
• RESULTS
This lists the errors the flightcheck process has picked up. This can contain 
errors (which denote the PDF needs fixing and should not be used), warnings 
(where visual checking may be needed, such as using a font too small or a 
hairline that’s too thin) and information (for instance, where non-standard 
compression has been used), all based on the settings of the flightcheck 
profile used.
• DOCUMENT INFORMATION
This lists the details on the version and creator of the PDF, which can help in 
identifying problems.
• ENVIRONMENT
The version of Acrobat and operating system used to carry out the check.

Errors listed in the report can be isolated on the second page (where 
possible) using layers. Select View>Navigation Panels>Layers: error layers 
are shown at the top. Click the eye icon on or off to enable or disable layer 
visibility, so you can show just the problem object. In the lower portion are 
temporary, visual-only backgrounds that can be turned on and off to help 
identify objects. For instance, turn on a black background to make a white 
object easier to spot. Use the Output Preview>Object Inspector tool to list 
specific details about problem objects.

SOLVING PROBLEMS
COMMON ERRORS
Most PDF errors can be easily avoided by following the pass4press 
guidelines. Utilise the downloadable presets in combination with the correct 
colour profile for the job. Even though pass4press v11 concentrates on 
InDesign CC and QuarkXPress 9, older versions of both can export PDF/X-
1a files, as can Illustrator – and even Photoshop with a bit of tweaking. You 
can also make a PDF/X-1a file from a PostScript file – something that can 
be created on any computer with a PostScript driver and a copy of Adobe 
Distiller installed. If you’re using a non-standard application, try and match 
the guidelines in this brochure as closely as you can. Be realistic about the 
software you’re using: no matter how hard you try, a print PDF is going to be 
difficult to create from some packages.

PDF/X ERRORS
If you have a PDF which hasn’t been output to the PDF/X-1a standard it 
can look like it’s riddled with problems. Just re-exporting with the PDF/X-1a 
box ticked will usually remove most of the errors. The Output Intent is a key 
part of creating a PDF/X-1a and has to be there for the file to be valid, even 
though it is in effect just informational. A PDF/X-1a contains ‘flat’ CMYK: the 
Output Intent field tells the receiver what profile you used to export the PDF 
and how its content was theoretically prepared; it demonstrates that you’ve 
followed the correct spec. The Output Intent is set in the Output tab in 
InDesign or via the Output Colour Setup in XPress. When you open the PDF/
X-1a in Acrobat and view the Output Preview, the Output Intent profile is 
displayed by default at the top of the window (see the Check pages).

pass4press
version 11



12

DOCUMENT CREATION
• INCORRECT PAGE SIZE INFORMATION
A fundamental problem: the page size must be accurate from the start. 
Bleed must be set to allow for movement on press: extend out elements 
around the edge of the page into the bleed area to avoid unseemly white 
edges should a shift occur at trim stage.
• INSUFFICIENT OFFSET OF CROP MARKS
Crop marks should be set well outside the bleed area to avoid them 
becoming visible.
• STROKES ARE TOO THIN
Most presses are simply unable to print very thin lines, so pay attention to 
publishers’ specs.
• GRADIENT RESOLUTION TOO LOW
Gradients in vector illustrations or effects like drop shadows need to be 
of sufficient resolution to avoid a ‘stepped’ effect. Again, check publishers’ 
specs for guidance.

FONTS
• FONTS NOT EMBEDDED
The smooth output of text is always better when produced from the original 
font rather than the rasterised text (ie, turned into a bitmap image). For 
licensing reasons fonts can’t be freely transferred in an extractable format; 
embedding fonts in a PDF is a one-way method of making sure all the fonts 
used on a page are available for reproduction at maximum quality. If fonts 
are missing or unavailable, they are typically exchanged for Courier, which 
will not only ruin a design, but upset designers.
• OVERPRINT/KNOCKOUT OBJECTS
Be sure to use the tools in XPress and InDesign to check for these problems, 
which can typically cause text to disappear (or appear). The best approach 
is to avoid altering trapping options, but rather let experts at the printers 
handle it.

DIGITAL IMAGES
• TOTAL AREA COVERAGE (TAC) MAXIMUM EXCEEDED
This is where the total amount of ink laid down is more than the maximum 
allowed by the publication’s printing conditions. It’s another easy one to 
solve. The colour profile used when exporting a PDF controls the colour 
across the output CMYK separations: use the correct profile and you’ll 
never exceed the TAC. Remember that you need to consider the content 
origination as well: convert your images, logos and illustrations to the 
correct destination profile before creating the PDF, rather than letting the 
export process handle it. 
• PLACED IMAGE RESOLUTION TOO LOW
Low-resolution images will look pixellated and low quality. Even if you start 
with a 300dpi image, make sure that resizing it hasn’t reduced the effective 
resolution. 
• TOO MUCH COMPRESSION APPLIED
Overly compressing JPG images may give small file sizes but will also 
introduce visible artefacts into the image and degrade quality.

COLOUR AND TRANSPARENCY
• CONTAINS NON-CMYK ELEMENTS
RGB is never acceptable in a print PDF and spot colours rarely so, except 
on covers. If you’ve used reference swatches from, for instance, Pantone, 
convert them to CMYK before exporting the PDF.
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• WRONG COLOUR SPACE ASSIGNED
Set your colour management to use the appropriate ICC profile for the job.
• FILE CONTAINS TRANSPARENT ELEMENTS
This means the file hasn’t been exported as a PDF/X-1a. Live transparency is 
supported by the new PDF/X-4 format, but widespread usage is a long way 
off – it will have a big impact on existing workflows and responsibility. 
• FILE USES PDF V1.4 OR LATER
It might seem like we’re stuck in the past, using a 14-year old 1.3 version 
of the PDF format, but most of the PDF updates have added support for 
objects unrelated to printing. 

CONTRACT HARD PROOFS
• PROOF NOT PRODUCED FROM THE FINAL PDF OR THE PROOF’S COLOUR SPACE 
IS TOO WIDE
Proofs must be created from the PDF/X-1a file that will be printed, using 
a RIP/paper combination that accurately represent the printing conditions. 
Check publishers’ specs.

PDF/X-4
In July 2012 the Ghent Workgroup released their PDF Specification 
‘GWG2012_CMYK’ followed by a later addendum. This replaced their 
previous specifications that were based on PDF/X-1a (PDF version 1.3) 
with a new set based on PDF/X-4. So, what are the differences and should 
pass4press follow suit?
PDF/X-4, launched in 2008 by the ISO (15930-7:2008), and subsequently 
updated in 2010, specifies the use of PDF version 1.6 for the ‘complete 
exchange of printing data’. This format includes features added to the PDF 
format after version 1.3, including transparency and optional content layers.
Its adoption by print-centric publishers has been slow to date, but the 
format offers advantages over PDF/X-1a when considering cross-media 
publishing. Although not currently part of the GWG’s specifications PDF/X-4 
allows for RGB colour to be used so that rendering occurs much later in 
workflows, and thus differently according to whichever media is displaying 
it. The next GWG specifications will almost certainly permit RGB content 
though there is still an issue to be overcome regarding ambiguity in the 
PDF/X-4 standard. This anomaly means that two RIPs can produce different 
colour from the same data when rendering RGB and transparency blend 
spaces and still be considered as PDF/X-4-compliant.
For now, pass4press will continue to advise that PDF/X-1a is still the 
preferred specification for UK print, reflecting the views of the PPA’s 
members currently. Should momentum towards PDF/X-4 begin to increase 
then we will review the situation again and consider endorsing the GWG’s 
latest specifications.

ECI PROFILES FOR SURFACE FINISHED PRINT
Fogra have created two sets of characterization data based on 
FOGRA39 for matt and glossy laminated sheet-fed offset prints 

using OPP films. Applying laminates can affect the visual appearance of 
print colours by a delta-E of 5 on average and a maximum delta-E of 10. 
Therefore, proofing will require special profiles to accurately render colours.
FOGRA49 is based on the current ISO 12647-2:2004 standard paper 
type 1/2 for matt OPP film laminated sheets, and has an associated colour 
profile provided by the European Colour Initiative (ECI) called PSO_Coated_
v2_300_Matte_laminate_eci.icc.

WWW

pass4press
version 11

http://www.iso.org/iso/catalogue_detail.htm?csnumber=37880


14

FOGRA50 is based on the same paper type as FOGRA49 but with glossy 
laminated OPP film. Its associated profile is called PSO_Coated_v2_300_
Glossy_laminate_eci.icc.
However, a printer will require a normal FOGRA39-based proof of the print 
file to match on press which may look lighter than normal due to colour 
adjustments made when correcting for the laminated finishing; these surface 
finishing affects should not be compensated for.

ISO 12647-2:2013
Although the latest version of ISO’s process control standard for offset 
printing has been available for some time its impact on print publishing has 
yet to be seen. The new version replaces tone curves designed for film-
based processes with curves adjusted to CTP output, and has a new set of 
paper types representing a broader range of currently available coated and 
uncoated substrates which use optical brightening agents (OBA). There is 
also a new colour measurement condition called M1, published in 2009 
as ISO 13655, which more closely matches the D50 standard illuminant 
especially in the UV range. Solid CMYK target values have been revised 
accordingly.
These major changes will require new characterization data and associated 
ICC colour profiles to be created. Work on this began at the end of 
2013, undertaken by the European Colour Initiative (ECI), and research 
associations such as Fogra and Ugra – under the project name of ‘Fred15’ 
– see www.eci.org/en/projects/fred15 . To measure and evaluate print 
and proofs will require new lighting, new spectrophotometers and proofing 
papers with OBAs.
The Fred15 group’s advice is to wait until their planned 2015 launch of 
new data (FOGRA51/52/…) and profiles, together with tools and practical 
guidelines to help users implement the necessary changes.
Pass4press will be updated with respect to any changes in colour 
management advice and settings required as a result of these changes.
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